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1 iBienvenido a GUITAR RIG SESSION!

GUITAR RIG SESSION es la respuesta profesional de grabacidén para guitarristas, bajistas
y compositores. Consiste en dos productos: la compacta interfaz de audio GUITAR RIG
SESSION /0 y la version ESSENTIAL del programa GUITAR RIG 4, ampliamente aclamado
por la critica especializada.

El GUITAR RIG SESSION /0 es una interfaz de audio de gran calidad disefiada y optimiza-
da para su con GUITAR RIG 4. Constituye una tarjeta de audio profesional, provista de un
preamplificador de micr6fono con alimentacion fantasma y dos entradas para la conexién de
guitarras y bajos eléctricos asi como dispositivos de linea. Una salida de linea de dos canales
permite la conexidn del aparato a su sistema de altavoces y un enchufe estéreo permite la
conexion de los auriculares con manejo de volumen independiente.

Su robusta y compacta carcasa de metal fue disefiada para soportar todo tipo de situaciones,
desde el trabajo rutinario en el estudio hasta las exigentes condiciones de las actuaciones
en vivo.

En los capitulos siguientes describiremos las distintas caracteristicas del GUITAR RIG SESSION
|/0 y a sacar el maximo provecho de las mismas. Por favor, lea esta manual cuidadosamente
para poder familiarizarse con el producto.
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2 Antes de empezar: Observaciones importantes

Antes que nada, lea primero este capitulo cuidadosamente antes de emplear su GUITAR RIG
SESSION.

2.1 Numeros de serie y chapa identificadora

GUITAR RIG SESSION tiene dos numeros de serie. En la parte inferior del producto encon-
trara el niumero de serie del GUITAR RIG SESSION vy la chapa identificadora con el nombre
del modelo y otras especificaciones técnicas. El nimero de serie necesario para la activacion
del programa GUITAR RIG 4 esté situado en funda del CD del producto.

2.2 Usar la unidad de manera segura

Lea estas instrucciones atentamente para evitar dafios a su salud o al producto.

2.2.1 Advertencia

Para prevenir lesiones auditivas, observe las siguientes recomendaciones de seguridad:

e Este producto combinado con un amplificador, auriculares o altavoces puede generar so-
nidos de volumen muy alto perjudiciales para el oido.

e Para su proteccidn, baje todos los niveles de volumen antes de empezar a usar GUITAR
RIG SESSION 1/0 . Al tocar la musica, eleve gradualmente los respectivos controles de vo-
lumen para establecer el nivel deseado.

e No lo utilice durante tiempos prolongados a volumenes elevados. Si experimenta problemas
auditivos o zumbidos en los oidos, consulte inmediatamente al médico.
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2.2.2 Precauciones

Para asegurar que GUITAR RIG SESSION 1/0 o cualquier otro dispositivo conectado al mismo
no resulte dafiado durante su uso o mantenimiento, es importante que siga las siguientes
instrucciones:

e No abra el dispositivo ni intente desarmarlo o modificar su interior. El dispositivo tiene com-
ponentes que no pueden ser reparados por el usuario. Si el aparato no funcionara correc-
tamente, suspenda inmediatamente su uso y hagalo revisar por personal calificado.

e No exponga el aparato a la lluvia y no lo utilice cerca del agua o en condiciones de hume-
dad.

e FEvite la penetracidn de cualquier objeto o liquido en la unidad.

e Nunca use o guarde la unidad en lugares sujetos a temperaturas extremas (p. €j., bajo la
luz directa del sol en un automovil o cerca de la calefaccion) o a altos niveles de vibracion.

® No coloque el GUITAR RIG SESSION I/0 en una posicidn inestable en la que pueda caer
al piso accidentalmente. Antes de mover la unidad, desenchufe los cables conectados.

e Antes de encender o apagar algiin componente, ponga a minimo el volumen del mismo.
e No emplee excesiva fuerza al usar los botones, perillas, interruptores o conectores.

e Para la limpieza de GUITAR RIG SESSION /O, utilice un pafio suave y seco. No emplee
solventes, liquidos limpiadores o pafios con quimicos limpiadores.

2.2.3 Deposicion del producto

Si por alguna causa el producto se estropeara sin posibilidad de arreglo o si llegara al término
de su vida util, cumpla con las regulaciones de su pais relativas a la deposicién de residuos
electrénicos.

GUITAR RIG SESSION - 8



2.3 Descargo de responsabilidad

Native Instruments GmbH no puede ser responsabilizada por dafio, pérdida o destruccién de
datos causados por uso indebido o modificaciones realizadas a GUITAR RIG SESSION 1/0.

La informacion contenida en este manual es la correcta al momento de su impresion o apari-
cidon digital. Sin embargo, Native Instruments se reserva el derecho de realizar modificaciones
a las especificaciones existentes, en cualquier momento, y sin previo aviso ni obligaciéon de
actualizar las unidades existentes.
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3 El hardware del SESSION 1/0

Este capitulo le brindard un panorama general de la mecanica del SESSION 1/0.

3.1 Panel frontal

1 La entrada de micréfono(Mic) presenta enchufes XLR (balanceados). Sirven para conec-
tar el microfono al preamplificador de la unidad para la entrada 1. Habilite por favor la
alimentaciéon fantasma para los micr6fonos de condensador.

2 El enchufe de Input 1 (conector de %", TRS balanceado) acepta la entrada de senales
de linea o de instrumento, dependiendo de como esté puesto el interruptor Line/Inst.
Conecte aqui su guitarra, bajo o teclado, o el canal izquierdo de un dispositivo estéreo.

3 El enchufe de Input 2 (conector de %", TRS balanceado) acepta la entrada de senales
de linea o de instrumento, dependiendo de como esté puesto el interruptor Line/Inst.
Conecte aqui una guitarra, bajo o teclado, o el canal derecho de un dispositivo estéreo.

] Tenga en cuenta que esta entrada tiene prioridad por sobre la entrada XLR (1). Por lo que
= cuando esta en uso, la entrada XLR quedara automaticamente deshabilitada.
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4 Esta perilla controla la ganancia de la entrada (Input) 1.
9 Esta perilla controla la ganancia de la entrada (Input) 2.

6 El interruptor Inst/Line establece la sensibilidad de entrada para las entradas 1 y 2.
Cuando no esta presionado, las entradas aceptan sefiales provenientes de instrumentos
como guitarras o bajos; cuando esta presionado, aceptan sefales de linea. El tipo de
entrada seleccionado se indica en la parte de arriba de la unidad.

1 Esta perilla ajusta el volumen de salida (Output 1/2).
8 Enchufe de auriculares para la conexion de sus auriculares estéreo.

9 Esta perilla ajusta el volumen de salida de los auriculares.

3.2 Panel superior

& GQuitarRigsession H'E_': ("

1 Este campo muestra el tipo de sefial seleccionado (micréfono, instrumento o linea) de
la entrada 1.

2 Este LED indica la presencia de sefial en la entrada 1/2.
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3 Este LED indica la presencia de distorsién en la entrada 1/2 (por lo tanto, no deberia
encenderse al estar tocando musica).

4 Este campo muestra el tipo de sefial seleccionado (micréfono, instrumento, linea) de la
entrada 2.

5 Este LED indica si la alimentacién fantasma ha sido activada.

3.3 Panel posterior

1 Estos enchufes transmiten la sefal recibida al ordenador. Las salidas TRS funcionan con
conectores balanceados y no balanceados. Asegurese de utilizar ambas salidas si desea
lograr sonido estéreo.

2  Esta ranura acepta candados de seguridad Kensington™ y compatibles. Usela para ase-
gurar su unidad contra robos.

3 El puerto USB conecta la unidad con el ordenador. Su ordenador tiene que aceptar USB
2.0 para poder trabajar con GUITAR RIG SESSION I/0 . La unidad también se alimenta
de la energia eléctrica transmitida a través del puerto USB. Conecte la unidad directa-
mente en un puerto USB 2.0 del ordenador y evite el empleo de concentradores (hubs)
sin fuente de alimentacion propia.

GUITAR RIG SESSION - 12



4 El interruptor de alimentacién fantasma de 48 V suministra la energia eléctrica a la en-
trada (1) XLR de micr6fono. Los micréfonos de condensador funcionan con alimentacion
fantasma mientras que los otros tipos de micréfonos no. Para evitar serios dafos, ase-
gurese de que la alimentacién fantasma esté apagada al conectar micréfonos dinamicos

o de cinta.
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4 Instalacion en Windows XP / Windows Vista

Este capitulo describe la instalacion del SESSION 1/0 en Windows XP y en Windows Vista.

Para mas informacion sobre el programa GUITAR RIG 4, consulte el manual de dicha aplica-
cion. El mismo se encuentra en el CD del producto o en el menu de GUITAR RIG 4 bajo la
opcién Help > Open Manual > Your Language.

4.1 Instalacion del programa

Aseglrese de haber iniciado la sesién con privilegios de administrador. No conecte todavia
el GUITAR RIG SESSION 1/0 .

1. Revise el contenido del CD para ubicar el archivo de instalacion. EI mismo se llama “Guitar
Rig 4 Setup”. Si esta empleando una version descargada de GUITAR RIG 4, deberé pri-
mero extraer el archivo de instalacion.

2. Haga doble clic sobre el archivo denominado “Guitar Rig 4 Setup” para iniciar el proceso
de instalacion.
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r

D Mative Instruments Guitar Rig 4 - Installiware Wizard E|§||g|

Welcome to the Native Instruments
Guitar Rig 4 Setup

Mote: &fter installation, do not move or rename the application
or the installation directory of the application, Otherwise, wou wil
nat be able ta run update installers,

Please make sure that the Guitar Rig 4 hardware is
not connected during this installation!

To conkinue, click Mext,

Mext = ] l Cancel

Siga las instrucciones en pantalla que lo guiaran a través del proceso de instalacion.

Se le pedira determinar la ruta a la carpeta del plugin de su EAD (estacién de audio
digital; p.ej., su programa secuenciador). Si desea usar GUITAR RIG 4 exclusivamente
en el modo standalone (independiente) o si no sabe bien lo que es un plugin, utilice
simplemente la opcidn estandar.

Se le preguntara si desea instalar los controladores para las interfaces de audio de GUITAR
RIG. Seleccione “SESSION 1/0” y haga clic en “Continue”.

Durante la instalacién, Windows mostrara varios mensajes de seguridad, p. e].: “El contro-
lador no ha pasado el logotipo de Windows” o “Windows no puede verificar el proveedor
de este controlador de programa”. No se preocupe, todo esta bien. Simplemente, haga
clic en “Continuar de todos modos” (Windows XP) o en “Instalar de todos modos el soft-
ware de controlador” (Windows Vista) y prosiga con la instalacion.
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Software Installation

] 'l_., The software you are instaling has not passed Windows Logo
= testing to werfy its compatibility with Windows XP. (Tell me why
this testing is important.)

Continuing your installation of this software may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the software vendor for software that has
passed Windows Logo testing.

[ Continue Amyway ] l STOP Installation

1. Completada la instalacidn, reinicie el ordenador.

Las siguientes aplicaciones han sido instaladas en el ordenador:
e GUITAR RIG 4 - la aplicacion standalone con todas sus caracteristicas.

e GUITAR RIG 4 plugins: una version plugin de GUITAR RIG 4 que podréa integrar a su esta-
cion de audio digital (EAD). En ordenadores con Windows, GUITAR RIG 4 acepta los for-
matos de plugin VST y RTAS® .

e Native Instruments Service Center: esta aplicacion se encarga de la activacion del produc-
to y gestiona las actualizaciones del mismo. Consulte la guia “Setup Guide” para mas infor-
macion.

e | os controladores de la interfaz de audio GUITAR RIG SESSION [/0O.

Si es propietario por primera vez de un producto NATIVE INSTRUMENTS, debera re-
gistrarse siguiendo las instrucciones ofrecidas en pantalla. Para méas informacién sobre
como crear una Cuenta de Usuario NI y sobre la activacion de GUITAR RIG 4, consulte la Guia de
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inicio rapido del Centro de Servicio y el manual ubicados en la carpeta de instalacion del Centro
de Servicio.

Si solamente desea instalar los controladores del aparato, en el CD de instalacion hallara por
separado el correspondiente archivo de instalacion del controlador. También podra descargar
la Gltima versién del mismo en la seccidén de asistencia (Support) del sitio de Internet de
Native Instruments.

4.2 Instalacion del aparato

Utilice el cable USB suministrado para conectar el SESSION /O directamente en un puerto
USB 2.0 del ordenador.

El SESSION 1/0 se alimenta a través de la conexién USB. Su operacidn so6lo puede garanti-
zarse si se lo emplea como dispositivo unico de un controlador USB 2.0 o con un hub USB
2.0 con fuente de alimentacién propia. En Windows XP, el SESSION 1/0 solamente funciona
a partir de la version Service Pack 2; podra averiguar la version de su sistema operativo en
la ventana de propiedades del sistema.
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Systemn Hestore Automatic Updates Remate
General Computer Name Hardware Advanced

System:
Microsaft Windows XP

r Professional
/I 'lj Wersion 2002
11/ Service Pack 2

Feaistered to:

&

_ﬁ_'

Dell Latitude D&30

Intel{R) Core{TM)2 Dua CPL
T9300 @ 2.50GHz

2 45GHz, 1.95 GB of RAM
Physical Address Bxtension

[ Support Infamation ]

I oK H Cancel ]

Tras la correcta instalacién del controlador, el SESSION /0O sera reconocido automaticamente.

Si esto no llegara a ocurrir, inicie nuevamente la instalacion del programa de la manera ya
descrita.

Ahora, los modulos del controlador seran asignados al SESSION 1/0 y cada uno de ellos abrira
una ventana para preguntarle de que manera desea instalar el nuevo dispositivo.

1. Seleccione “no conectar con el sitio web Windows Update”.

2. Seleccione “Instalar el programa automaticamente” (Windows XP) o “Localizar e instalar
el controlador del programa” (Windows Vista).
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Found New Hardware Wizard

This wizard helps you install software for:

Sezzion |/0

-j if your hardware came with an installation CD
= orfloppy disk. insert it now.

What do you want the wizard to do?

{?} Install the software automatically (Recommended)
) Install from a list or specific location {Advanced)

Click Mext to continue.

< Back ” Mexd = ][ Cancel

3. Siga las instrucciones de pantalla hasta completar el procedimiento.

4. Los avisos de seguridad de Windows comenzaran a aparecer. Haga clic en la opcidn
“Continuar de todos modos” (Windows XP) o “Instalar el software de controlador (Windows
Vista) para que los controladores se instalen correctamente.

En un ordenador con Windows, el controlador esta asociado a un puerto USB en particular.
Si enchufa el cable USB en un puerto diferente del puerto de instalacion original, el proceso
de asignacioén del controlador podria comenzar nuevamente: si esto sucediera, simplemente
siga los pasos explicados mas arriba..

Si en algun momento, el ordenador parece no reconocer el SESSION 1/0, desconecte el ca-
ble USB, espere unos segundos y vuelva a conectarlo. Si el problema continua, reinicie el
ordenador teniendo la interfaz conectada.
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4.3 Configuracion

Este capitulo describe el empleo de la interfaz de audio SESSION 1/0 en Windows XP/Windows
Vista, atendiendo especialmente su uso conjunto con GUITAR RIG 4. Vamos a suponer que
usted ya ha activado su GUITAR RIG 4 a través del Centro de Servicio, (consulte la guia

“Setup Guide”

para mas informacion).

4.3.1 Configurar GUITAR RIG 4
Ahora vamos a configurar GUITAR RIG 4 para su uso con la interfaz de audio RIG KONTROL.

Primero, inicie

el programa.

1. Cuando el programa arranque por primera vez, la ventana de configuraciéon de audio
“Audio Setup” aparecera automaticamente para que pueda llevar a cabo las configura-
ciones correspondientes. Para abrir esta ventana en un momento posterior, en la barra

de menu del programa seleccione File > Audio and MIDI Settings.

Audio and MIDI Settings...

Routing MIDI (v |

Audio

Driver (Asio -]
Device  Asl0 Config | [ Session I/0 -]
Status Running
Sample Rate (44100 -]
Latency 88 Samples
Input» 2.5 ms | Processing » 2.0ms | Output» 4.5 ms | Overall » 9.0 ms

(O cancel | [ @ ok |

2. Abra la ficha ,,Audio” y en ,,Driver* seleccione ASIO como la interfaz del controlador.

3. Seleccione SESSION 1/0 en el menu de dispositivos (“Device”).
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Si SESSION 1/0 no aparece en la lista, entonces algo sali6 mal. Vuelva a efectuar la instala-
cion de la manera ya descrita.

Podra acceder al panel de control del controlador al cliquear sobre el botén “ASIO Config”.
El panel de control del controlador presenta abajo dos campos de lectura de estado que le
indicaran si el SESSION 1/0O esta conectado y listo para ser utilizado.

Oi Native Instruments Session 1/0 Control Panel g|§|@|

Soundcard Latency Settings

Presets: |minimal latency [low CPU usage sibuation] ﬂ

Thiz setting offers a minimunn output latency of ~8 me [3 ms input to
autput] but should only be uzed in zituations with low CPL uzage.

LISE Buffersize:; Audio Buffersize:

Buffer Format

Sample Hate: |44'IEIEIH2 -|

About

Ready connecked

La interfaz de audio permite la configuracion de los siguientes parametros:

® Presets: se incluyen varios presetes destinados a los usos mas frecuentes; desde presetes
con latencia minima para sistemas rapidos con mucha capacidad de procesamiento hasta
presetes con latencias mas altas, para sistemas mas lentos. Si usted ya tiene experiencia
en la configuracion de controladores de audio y desea crear su propio juego de configura-
ciones, seleccione entonces la opciéon “User Defined Settings” (ver abajo).

e USB Buffersize y Audio Buffersize: estos parametros aparecen de color gris si la opcion
User Defined Settings no fue seleccionada en el el menu de Presets. Juntos, estos para-
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metros definen el sistema de latencia, es decir, el tiempo que pasa desde el momento en
que la sefal de audio se envia al hardware de SESSION 1/0 y el momento en que dicha
sefial es oida a través de los auriculares o altavoces. Tenga en cuenta que el valor de Audio
Buffersize debera ser por lo menos dos veces mayor que el valor de USB Buffersize. El
tamafio del bufer del USB (USB Buffersize) incide directamente en el uso de CPU por par-
te del sistema. EI consumo resultante de CPU difiere mucho de un ordenador a otro, por lo
que es una buena idea ir probando distintas configuraciones.

e Sample Rate: seleccione una frecuencia de muestreo que sea compatible con su programa
de musica y con la capacidad de célculo del ordenador. Por defecto, la frecuencia de mues-
treo esta puesta en 44100 Hz (calidad de CD). Frecuencias mas altas pueden mejorar la
calidad del sonido pero exigiran, a su vez, una capacidad de procesamiento mayor.

Recomendamos que pruebe primero los tres presetes de latencia que aparecen en primer
término y luego continuar con los restantes pasos de la instalacion. Cuando haya terminado,
en algn momento posterior deberia revisar nuevamente la ficha Audio and MIDI Settings y
determinar cual es la mejor latencia para su sistema. Si experimenta fallas en el audio con
el preset minimal latency, pruebe las configuraciones low latency o standard latency. Valores
de latencia mas altos reduciran la probabilidad de sufrir problemas con el audio.

4.3.2 Emplear el SESSION 1/0 como la interfaz de audio predeterminada

Si desea usar el SESSION 1/0 para reproducir todas las aplicaciones de audio de su ordena-
dor (y no solo el software de musica), debera configurarlo para que sea la interfaz de audio
predeterminada del sistema.

En Windows XP haga lo siguiente:
1. Abra Inicio > Panel de control > Sonidos y dispositivos de audio.
2. Seleccione la ficha “Audio”.

3. En “Reproduccién de sonido” y en “Grabacién de sonido”, haga clic en el menu de dis-
positivos predeterminados y seleccione SESSION [/0.

4. Haga clic en Aceptar para cerrar el didlogo de “Sonidos y dispositivos de audio”.

GUITAR RIG SESSION - 22



Sounds and Audio Devices Properties
YWolume Sounds Audio Waoice Hardware

Sound playback

Diefault device:

4 Sezszion A0 Output

Yolume. .. ] [ Advanced. ..

Sound recording

ﬁ Diefault device:
Seszion | /0 Input

MIDI music playback

% Ciefault device:

S5 Microsoft G5 Wavetable SW Syrth

[ Volume... ] [ About...

[ ] Use only default devices

| ok || cencel || Apol

En Windows Vista haga lo siguiente:

1
2
3.
.
5
6

Abra Inicio > Panel de control > Hardware y sonido > Sonido.
Seleccione la ficha “Reproduccién”.

En la lista de dispositivos, seleccione SESSION 1/0 y luego haga clic en “Predeterminar”.

Seleccione la ficha “Grabar”.

En la lista de dispositivos, seleccione SESSION I/0 y luego haga clic en “Predeterminar”.

Haga clic en Aceptar para finalizar.
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4.4 Conexiones de audio y niveles

En los capitulos siguientes aprendera la manera de conectar el SESSION 1/0O a su guitarra y
sistema de altavoces, y a establecer los niveles de amplificacion correctos tanto en el aparato
como en el programa.

Antes de continuar, inicie GUITAR RIG 4.

4.4.1 Conectar el instrumento y ajustar el volumen de entrada
1. Baje el volumen de su sistema de monitorizacion para evitar lesiones auditivas.

2. Asegurese de que el selector de entradas esté puesto en “Instrument” (el botdn no esta
oprimido), salvo si quiere emplear un preamplificador para reforzar la sefial hasta el nivel
de linea.

3. Enchufe el cable de su guitarra o bajo en una de las entradas del SESSION 1/0.

4. Baje el volumen del canal de entrada que no esta usando.

Tenga en cuenta que los instrumentos que generan sefiales estéreo, como por ejemplo los
sintetizadores de teclado, deberan ser conectados a ambos canales de entrada para obtener
sonido estereofdnico.
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Para obtener la mejor calidad de sonido posible, debera suministrarle a la interfaz una sefal
que sea lo suficientemente potente; por lo que deberia ajustar cuidadosamente el volumen
de entrada del SESSION 1/0.

Los LED de entrada (INPUT) sefialan el volumen de la sefal entrante en cada canal:

LED de estado

Significado

LED apagado

La senal no esta presente.

LED verde

Se esta registrando el ingreso de la senal.

LED rojo

El volumen de la senal entrante es muy alto.

Antes de ajustar la sensibilidad de entrada, baje la perilla de volumen de su guitarra. Toque
algunos acordes al volumen al que acostumbra tocar y eche un vistazo al LED del canal em-

pleado:

1. Mientras esta tocando, suba la correspondiente perilla de volumen justo hasta que el LED
de la distorsién empiece a encenderse.

2. Ahora, baje despacio la perilla hasta que el LED de la distorsidon no se encienda mas,
aun al tocar acordes muy fuertes.

Ahora la sensibilidad de entrada esta puesta en un nivel 6ptimo y el SESSION /0 puede
proporcionar un rango dindmico muy alto sin caer en distorsion.

4.4.2 Conectar un segundo instrumento

Es posible conectar un instrumento en cada canal siempre que los mismos suministren el
mismo tipo de sefal (linea o instrumento). Enchufe el cable de un segundo instrumento en
la otra entrada y ajuste el nivel de volumen de la manera descrita en el apartado anterior.

Para instrumentos que generan una sefial estéreo, es necesario utilizar también el segundo
canal para lograr asi un sonido estereofonico.
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4.4.3 Elvolumen de entrada de GUITAR RIG 4

Vamos a dar por sentado que su guitarra ya esta conectada al SESSION 1/0 y que su nivel de
entrada fue correctamente ajustado (véase el apartado 4.4.1). Ahora debemos asegurarnos
de que la sefal de entrada sea procesada por el programa a un nivel adecuado.

Eche un vistazo a la cabecera de GUITAR RIG 4: esta compuesta por un mddulo de entrada
con selectores de canal (I/r), un supresor de ruido (Gate) sencillo, un mddulo de salida con
un limitador y, finalmente, la informacién del consumo de CPU.

Para una descripcion y explicacion detallada del circuito de reduccion de ruidos, consulte el
manual de dicha aplicacion.

Tenga en cuenta que el Medidor de entrada mostrara la amplitud al tocar el instrumento.
También hallara un deslizante de volumen que controla el nivel de entrada del software.
Ajuste este control hasta conseguir el nivel mas alto posible sin producir distorsion. Esto lo
podra comprobar con el Medidor de volumen, que se acercara hasta la zona roja sin llegar
realmente a alcanzarla.

Si solamente una guitarra se hallara conectada, GUITAR RIG 4 recibira una sefial mono. Usted
puede también configurar el médulo de entrada para que direccione la sefial de su guitarra a
través de ambos canales. Por defecto, GUITAR RIG 4 esta configurado para procesar ambos
canales de entrada (I + r estan activados), por lo que uno de los canales permanecera, enton-
ces, en silencio. Para cambiar esto desactive el canal que no esté usando: cliquee el boton
correspondiente (I o r) a la izquierda del medidor de entrada para desactivar dicho canal y
gue solamente quede activo el canal de entrada en uso. Con esto dirigira la sefial monoaural
hacia ambos canales.

4.4.4 Conectar la salida

El SESSION /0 proporciona dos salidas mono (L/R) que le serviran para la conexion de su
sistema de monitorizacion, sea éste una mesa de mezclas, un par de altavoces activos o el sis-
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tema estéreo de su casa. Tenga en cuenta que para lograr un sonido estéreo, debera conectar
los dos altavoces. Un salida estéreo separada (TRS) permite la conexion de sus auriculares.

i use

| - |

®

1. Conecte las salidas del aparato con la entrada de su sistema de amplificacion, ponga el
volumen en su nivel habitual y baje la perilla de volumen de salida.

2. Si estad usando auriculares, conéctelos en el enchufe de salida y tenga la precaucidn de
bajar el volumen antes de ponérselos.

3. Vaya al buscador de presetes y seleccione un preset con un clic. Empiece a tocar y vaya
subiendo cuidadosamente el volumen de salida o de auriculares del SESSION /0O hasta
alcanzar el nivel deseado.

Si su instrumento emplea solamente un canal, ponga la perilla de ganancia del otro canal en

cero.

Ahora todo esta listo, jya puede empezar a tocar!
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5 Instalacion en Mac 0S X

Este capitulo describe la instalacion béasica del SESSION /0 en MAC OS X.

Para mas informacion sobre el programa GUITAR RIG 4, consulte el manual de dicha aplica-
cion. El mismo se encuentra en el CD del producto o en el menu de GUITAR RIG 4 bajo la
opcién Help > Open Manual > Your Language.

9.1 Instalacion del programa

Aseglrese de haber iniciado la sesién con privilegios de administrador. No conecte todavia
el SESSION 1/0 .

1. Revise el contenido del CD y ubique el archivo “Guitar Rig 4 Installer”. Si esta empleando
una version descargada de GUITAR RIG 4, debera primero extraer el archivo de instala-
cion.

2. Haga doble clic sobre el archivo de instalacion para iniciar el proceso de instalacion.

00 « Install Guitar Rig 4

Welcome to the Guitar Rig 4 Installer

@ Introduction

Note: Afterinstallation, do not move or rename the
application or the installation directory of the
application. Otherwise, you will not be able to run
update installers.

(NIN

H
~ Continue
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3. Siga las instrucciones en pantalla que lo guiaran a través del proceso de instalacion.

4. Se le preguntara si desea instalar los controladores para las interfaces de audio de GUITAR
RIG. Seleccione “SESSION 1/0” y haga clic en “Continue”.

9. Completada la instalacion, reinicie el ordenador.

Las siguientes aplicaciones han sido instaladas en el ordenador:
e GUITAR RIG 4 - la aplicacion standalone con todas sus caracteristicas.

e GUITAR RIG 4 plugins: una version plugin de GUITAR RIG 4 que podréa integrar a su esta-
cién de audio digital (EAD). En ordenadores con Mac OS X, el programa acepta los forma-
tos VST, AU y RTAS® .

e Native Instruments Service Center: esta aplicacion se encarga de la activaciéon del produc-
to y gestiona las actualizaciones del mismo. Consulte la guia “Setup Guide” para mas infor-
macion.

e | os controladores de la interfaz de audio SESSION [/0O.

Si es propietario por primera vez de un producto NATIVE INSTRUMENTS, deberé registrarse

siguiendo las instrucciones ofrecidas en pantalla. Para mas informacion sobre como crear
una Cuenta de Usuario NI y sobre la activacion de GUITAR RIG 4, consulte la Guia de inicio rapido
del Centro de Servicio y el manual ubicados en la carpeta de instalacién del Centro de Servicio.

Si solamente desea instalar los controladores del aparato, en el CD de instalacién hallara por
separado el correspondiente archivo de instalacion del controlador. También podra descargar
la altima version del mismo en la seccidn de asistencia (Support) del sitio de Internet de
Native Instruments.
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5.2 Instalacion del aparato

Utilice el cable USB suministrado para conectar el SESSION /O directamente en un puerto
USB 2.0 del ordenador.

El SESSION 1/0 se alimenta a través de la conexion USB. Su operacién sélo puede garanti-
zarse si se lo emplea como dispositivo unico de un controlador USB 2.0 o con un hub USB

2.0 con fuente de alimentacion propia.

Tras la correcta instalacion del controlador, el SESSION 1/O sera reconocido automaticamen-
te. Si en algin momento, el ordenador parece no reconocer el SESSION /O, desconecte el
cable USB, espere unos segundos y vuelva a conectarlo. Si el problema continua, reinicie el
ordenador teniendo la interfaz conectada.
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5.3 Configuracion

Este capitulo describe el empleo de la interfaz de audio SESSION 1/0 en Mac OS X, aten-
diendo especialmente su uso conjunto con GUITAR RIG 4. Vamos a suponer que usted ya ha
activado su GUITAR RIG 4 a través del Centro de Servicio, (consulte la guia “Setup Guide”
para mas informacion).

3.3.1 Configurar GUITAR RIG 4

Ahora vamos a configurar GUITAR RIG 4 para su uso con la interfaz de audio RIG KONTROL.
Primero, inicie el programa.

1.

2.
3.

| A Audio and MIDI Settings...

Audio ‘ Routing MIDI ()
Driver [ coreAudio -]
Device [ Session 1/0 (2 In, 2 Out) -]
Status Running
Sample Rate (44100 -]
Latency 512 Samples | [} )
Input » 16.0 ms | Processing » 11.6 ms | Output » 5.8 ms | Overall » 33.4 ms

(@ cancel | [ @ oK

Seleccione SESSION 1/0 en el menu de dispositivos (“Device”).

Cuando el programa arranque por primera vez, la ventana de configuracién de audio
“Audio Setup” aparecera automaticamente para que pueda llevar a cabo las configura-
ciones correspondientes. Para abrir esta ventana en un momento posterior, en la barra
de menu del programa seleccione Guitar Rig 4 > Preferences.

Abra la ficha ,,Audio”, y en ,,Driver”, seleccione CoreAudio como la interfaz del controlador.
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Si SESSION 1/0 no aparece en la lista, entonces algo salié mal. Vuelva a efectuar la instala-
cion de la manera explicada en el apartado 5.1.

La interfaz de audio permite la configuracion de los siguientes parametros:

e Sample Rate: seleccione una frecuencia de muestreo que sea compatible con su programa
de musica y con la capacidad de célculo del ordenador. Por defecto, la frecuencia de mues-
treo esta puesta en 44100 Hz (calidad de CD). Frecuencias mas altas pueden mejorar la
calidad del sonido pero exigiran, a su vez, una capacidad de procesamiento mayor.

e Latency: el deslizante de latencia permite establecer el tamafio del bufer de la interfaz de
audio (medido en samples). Esto presenta dos efectos: cuanto mayor sea el tamafio del
bufer, menor sera la probabilidad de experimentar problemas en el audio cuando éste sea
procesado en tiempo real. Por otra parte, el tamafio del bufer afecta directamente la laten-
cia general del sistema. Si incrementa el tamafio del bufer, el tiempo transcurrido entre la
gjecucion de una nota y el momento cuando ésta suena sera mayor.

Recomendamos empezar primero con el tamafo de bufer predeterminado y continuar con
los restantes pasos de la instalacién. Cuando haya finalizado, deberia cargar un preset limpio
y simple, y abrir la opcion “Audio and MIDI Settings” para buscar la mejor latencia para su
sistema. Esto se logra moviendo paulatinamente el deslizante de Latency hacia la izquierda
mientras se esta tocando algo. Si empieza a percibir ruidos o fallas, arrastre lentamente el
deslizante hacia la derecha hasta que los mismos cesen por completo.

9.3.2 Emplear el SESSION 1/0 como la interfaz de audio predeterminada

Si desea usar el SESSION 1/0 para reproducir todas las aplicaciones de audio de su ordena-
dor (y no sélo el software de musica), debera configurarlo para que sea la interfaz de audio
predeterminada del sistema.

1. Desde el menu de Apple, seleccione Preferencias del sistema:
2. En el panel que se abre, seleccione “Sonido”.
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00 Sound

{ Sound Effects | Output  Input |

Nare | Type

Basso Built-in
Blow Built-in
Bottle Built-in

Built-in

Play alerts and sound effects through: ['Session /O

Alert volume: ﬂ

—

0 )

Wi Play user interface sound effects
a Play feedback when volume is changed
™ Play Front Row sound effects

Output volume: = 9,

SShow volume in menu bar

ﬂ))) M Mute

« v B |

En la ficha de efectos de sonido seleccione la opcién SESSION /O en el menu de
“Reproducir alertas y efectos de sonido”.

Cliquee la ficha de “Salida” y seleccione SESSION 1/0 en la lista de “Seleccionar un
dispositivo para la salida de sonidos”.

Haga clic en la ficha “Entrada” y seleccione SESSION 1/0 en la lista de “Seleccionar un
dispositivo para la entrada de sonidos”.
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9.4 Conexiones de audio y niveles

En los capitulos siguientes aprendera la manera de conectar el SESSION 1/0O a su guitarra y
sistema de altavoces, y a establecer los niveles de amplificacion correctos tanto en el aparato
como en el programa.

Antes de continuar, inicie GUITAR RIG 4.

9.4.1 Conectar el instrumento y ajustar el volumen de entrada
1. Baje el volumen de su sistema de monitorizacion para evitar lesiones auditivas.

2. Asegurese de que el selector de entradas esté puesto en “Instrument” (el botdn no esta
oprimido), salvo si quiere emplear un preamplificador para reforzar la sefial hasta el nivel
de linea.

3. Enchufe el cable de su guitarra o bajo en una de las entradas del SESSION 1/0.

4. Baje el volumen del canal de entrada que no esta usando.

Tenga en cuenta que los instrumentos que generan sefiales estéreo, como por ejemplo los
sintetizadores de teclado, deberan ser conectados a ambos canales de entrada para obtener
sonido estereofdnico.
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Para obtener la mejor calidad de sonido posible, debera suministrarle a la interfaz una sefal
que sea lo suficientemente potente; por lo que deberia ajustar cuidadosamente el volumen
de entrada del SESSION 1/0.

Los LED de entrada (INPUT) sefialan el volumen de la sefal entrante en cada canal:

LED de estado Significado

LED apagado La senal no esta presente.

LED verde Se esta registrando el ingreso de la senal.
LED rojo El volumen de la senal entrante es muy alto.

Antes de ajustar la sensibilidad de entrada, baje la perilla de volumen de su guitarra. Toque
algunos acordes al volumen al que acostumbra tocar y eche un vistazo al LED del canal em-
pleado:

1. Mientras esta tocando, suba la correspondiente perilla de volumen justo hasta que el LED
de la distorsién empiece a encenderse.

2. Ahora, baje despacio la perilla hasta que el LED de la distorsidon no se encienda mas,
aun al tocar acordes muy fuertes.

Ahora la sensibilidad de entrada esta puesta en un nivel éptimo y el SESSION /0 puede
proporcionar un rango dindmico muy alto sin caer en distorsion.

9.4.2 Conectar un segundo instrumento

Es posible conectar un instrumento en cada canal siempre que los mismos suministren el
mismo tipo de sefial (linea o instrumento). Enchufe el cable de un segundo instrumento en
la otra entrada y ajuste el nivel de volumen de la manera descrita en el apartado anterior.

Para instrumentos que generan una sefial estéreo, es necesario utilizar también el segundo
canal para lograr asi un sonido estereofonico.
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5.4.3 Elvolumen de entrada de GUITAR RIG 4

Vamos a suponer entonces que su guitarra esta conectada a GUITAR RIG SESSION |/0 y que
el volumen de entrada ya fue ajustado adecuadamente (consulte el apartado 5.4.1). Ahora
debemos asegurarnos de que la sefial de entrada sea procesada por el programa con un
adecuado nivel de volumen.

Eche un vistazo a la cabecera de GUITAR RIG 4: esta compuesta por un mddulo de entrada
con selectores de canal (I/r), un supresor de ruido (Gate) sencillo, un mddulo de salida con
un limitador y, finalmente, la informacién del consumo de CPU.

Para una descripcién y explicacion detallada del circuito de reduccidn de ruidos, consulte
el manual de dicha aplicacion.

Tenga en cuenta que el Medidor de entrada mostrara la amplitud al tocar el instrumento.
También hallard un deslizante de volumen que controla el nivel de entrada del software.
Ajuste este control hasta conseguir el nivel mas alto posible sin producir distorsion. Esto lo
podra comprobar con el Medidor de volumen, que se acercara hasta la zona roja sin llegar
realmente a alcanzarla.

Si solamente una guitarra se hallara conectada, GUITAR RIG 4 recibira una sefial mono. Usted
puede también configurar el médulo de entrada para que direccione la sefial de su guitarra a
través de ambos canales. Por defecto, GUITAR RIG 4 esta configurado para procesar ambos
canales de entrada (I + r estén activados), por lo que uno de los canales permanecera, enton-
ces, en silencio. Para cambiar esto desactive el canal que no esté usando: cliquee el botdn
correspondiente (I o r) a la izquierda del medidor de entrada para desactivar dicho canal y
que solamente quede activo el canal de entrada en uso. Con esto dirigira la sefial monoaural
hacia ambos canales.
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5.4.4 Conectar la salida

El SESSION /0 proporciona dos salidas mono (L/R) que le serviran para la conexion de su
sistema de monitorizacion, sea éste una mesa de mezclas, un par de altavoces activos o el sis-
tema estéreo de su casa. Tenga en cuenta que para lograr un sonido estéreo, debera conectar
los dos altavoces. Un salida estéreo separada (TRS) permite la conexion de sus auriculares.

©®

1. Conecte las salidas del aparato con la entrada de su sistema de amplificacion, ponga el
volumen en su nivel habitual y baje la perilla de volumen de salida.

2. Si estad usando auriculares, conéctelos en el enchufe de salida y tenga la precaucion de
bajar el volumen antes de ponérselos.

3. Vaya al buscador de presetes y seleccione un preset con un clic. Empiece a tocar y vaya
subiendo cuidadosamente el volumen de salida o de auriculares del SESSION 1/0 hasta
alcanzar el nivel deseado.

Si su instrumento emplea solamente un canal, ponga la perilla de ganancia del otro canal en
cero.

Ahora todo esta listo, jya puede empezar a tocar!
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6 Solucion de problemas

Si se encontrara con algin problema en el funcionamiento de su unidad, antes de ponerse en
contacto con nuestra asistencia técnica, le recomendamos seguir los pasos siguientes para
encontrar una posible solucién.

e Visite el banco de conocimientos de NI. Puede acceder al mismo rapidamente desde el
menu de GUITAR RIG 4, seleccione Help > Knowledgebase.

e Visite el Foro de usuarios de NI (en (http://www.native-instruments.com/forum/) y busque
respuestas y consejos Utiles brindados por la comunidad de usuarios de GUITAR RIG.

Al ponerse en contacto con el equipo de asistencia técnica de Native Instruments, asegurese
de tener a mano toda la informacién relevante. Para saber la versién del controlador y del
firmware, consulte el panel de control del controlador.

® En los ordenadores con Windows, este panel se halla en el mena de Inicio, dentro de la
carpeta de programa GUITAR RIG 4. La informacion aparecera después de cliquear en
“’About”.

e En ordenadores con Mac OS X, puede acceder al Panel de control del controlador desde
el sistema de preferencias. La informacion aparecera en la ventana principal.

Visite por favor esta direccion URL para ponerse en contacto con nuestro equipo de asistencia
técnica:

http://www.native-instruments.com/support/

Todos los productos de NATIVE INSTRUMENTS han sido probados reiteradamente en situacio-
nes reales durante su fase de desarrollo. Sin embargo, si el producto necesitara ser devuelto,
el equipo de soporte técnico le dara un nimero de RA (Return Authorization) para tramitar el
procedimiento. Contactese con nuestro equipo de asistencia técnica antes de efectuar cual-
quier tipo de devolucion. Los paquetes que sean devueltos sin este nimero de RA no podran
ser correctamente identificados y no podrian ser procesados de manera eficiente.
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6.1 Problemas relacionados con el audio

Este apartado brinda informacion para los problemas de audio mas habituales que pudieran
sucedetr.

6.1.1 No hay sonido o suena poco volumen

Hay varias razones posibles por la cuales no se produce sonido o el mismo sale con poco
volumen:

e (Cables rotos o desconectados. Revise todos los cables y conexiones.

® Se ha seleccionado una tarjeta de sonido o una entrada de audio incorrecta. Verifique que
el controlador del SESSION /0 esté seleccionado en la opcién Audio and MIDI Settings del
menu de GUITAR RIG 4

e Se ha seleccionado el canal equivocado en el modulo de entrada de GUITAR RIG 4. Conecte
su instrumento en la otra entrada o seleccione “L” para cambiar de canal.

e | aganancia de entrada del SESSION 1/0 esta puesta muy baja. Suba la perilla hasta el
nivel deseado.

e | a perilla de volumen de su instrumento esta bajada. Suba la perilla de volumen.

6.1.2 Senal distorsionada

Si la sefial de audio suena distorsionada y, sin embargo, GUITAR RIG 4 no esta afiadiendo
ningun tipo de distorsién, lo mas probable es que la ganancia del SESSION 1/0 esté muy alta.
Reduzca el nivel de entrada de la interfaz para evitar que el preamplificador cause distorsion.
Si su instrumento produce una sefial tan alta como para que el preamplificador esté siempre
saturado, reduzca entonces su volumen. Normalmente, esto s6lo sucede cuando el instrumento
viene equipado con una electronica especial, como por ejemplo pastillas de alta salida.
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6.1.3 Ruido
Cuando se percibe zumbido, las razones que lo causan pueden ser variadas:

e | as pastillas de bobinado simple son propensas a recoger las interferencias eléctricas. Las
pastillas Humbucker producen mucho menos ruido.

e Su guitarra estd muy cerca del equipo eléctrico. Para reducir este tipo de zumbido, despla-
ce la guitarra mas lejos del equipo.

e | a perilla de volumen de la guitarra esta puesta muy bajo. Suba la perilla. Si la guitarra
cuenta con mas de una perilla de volumen, verifique el volumen de todas la perillas.

e Estd empleando un cable roto o que no esta debidamente protegido. La pantalla de la gui-
tarra podria no ser suficiente. Primero trate de reemplazar el cable por un modelo con
pantalla protectora. Si esto no funciona, un profesional deberia revisar la electronica de su
guitarra y dotarla de una proteccion mejor.

Si percibe siseo, el volumen de entrada del SESSION [/0 puede estar demasiado bajo. Suba
el volumen del instrumento o incremente el nivel de entrada del SESSION /0. Para mas
informacion sobre el ajuste del nivel de entrada, consulte la seccién 4.4 (Windows XP/Vista)
0 la seccién 5.4 (Mac OS X) de este manual.

6.1.4 Bucles de masa

Los bucles de masa (generalmente percibidos como un zumbido de baja intensidad) son un
problema frecuente que se produce cuando varios dispositivos eléctricos forma parte del
mismo circuito eléctrico. Los siguientes pasos lo ayudaran a eliminarlos:

e Desconecte todos los dispositivos que no esté usando, p. €j., dispositivos periféricos conec-
tados al ordenador (discos externos, grabadoras de CD, etc.).

e (Conecte una caja DI detras de las salidas del SESSION |/0 . La mayoria de estas cajas tie-
nen un interruptor que se usa para romper el bucle y eliminar de esta forma el ruido.
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6.2 Problemas relacionados con el hardware

Verifique la disponibilidad de actualizaciones y otras informaciones relativas a SESSION 1/0
en el sitio de Internet de Native Instruments y en el NI Service Center.

6.2.1 Problemas relativos al controlador

Asegurese de que SESSION 1/0 esté conectado al ordenador y abra el panel de control del
controlador. La ubicacién del mismo ya la hemos sefialado en la introduccion de este capitulo

Si el panel de control no se encontrara, es probable que el controlador no se haya podido
instalar. En este caso, vuelva a instalar el controlador de la manera descrita mas arriba en
este manual.

Si todos los menus desplegables del panel de control aparecen de color gris, significa que el
SESSION 1/0 no ha sido reconocido por el controlador. Es posible que algo no ande bien con
la conexion USB, la seccidn siguiente le brindara mas detalles al respecto.

6.2.2 Problemas relativos a la conexion USB

SESSION 1/0 es una interfaz USB 2.0 y no funciona en puertos USB 1.0 o 1.1 . Lo mejor
es conectar el aparato directamente en un puerto USB 2.0 del ordenador. Ademas, el puer-
to necesita cumplir los requisitos minimos de alimentacién eléctrica de un puerto USB 2.0
(500 mA). Algunos ordenadores no satisfacen el estandar oficial de alimentacion eléctrica
para puertos USB 2.0 . En este caso, es posible que un mensaje aparezca indicando que
no hay suficiente energia disponible para operar el dispositivo. SESSION 1/O podria entonces
producir crepitaciones o directamente no funcionar.

e Si su ordenador no puede suministrar suficiente energia, haga la prueba de conectar su
SESSION 1/0 en un hub USB 2.0 con fuente de alimentacidn propia. En este caso, deberia
evitar la conexién de otros dispositivos al hub, dado que éstos disminuirian la potencia total
disponible.

® En caso de fallas, resulta util comprobar si SESSION /0 funciona mejor al desconectar los
otros dispositivos USB del ordenador.
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e Si experimenta fallas en el audio o algun otro tipo de problema relacionado con la co-
nexién USB, conecte el SESSION 1/0 en otro puerto USB 2.0 del ordenador.

e Un cable USB en mal estado puede ser responsable de las caidas en el audio y de otros
problemas de conectividad. Pruebe con un cable diferente (con el logo oficial USB); en
algunos casos también resulta beneficioso emplear un cable més corto.

e Si SESSION /0 experimenta problemas de mal desempefio en una maquina Windows, lo
primero que deberia hacer es deshabilitar el control de alimentacion de los hub USB, que
siempre se encuentra activado por defecto. Vaya al administrador de dispositivos (Panel de
control > Sistema > Hardware) y haga clic con el botdn secundario en un hub USB para
abrir sus propiedades. En la pagina de control de alimentacion desmarque todas las casillas.
Repita esto para cada hub y luego reinicie el sistema.

6.2.3 Emplear el SESSION I/0 con un ordenador portatil

Primero deberia verificar que el ordenador sea apto para manejar el procesamiento de audio
en tiempo real sin experimentar fallas. En la red encontrara un par de herramientas gratuitas
que le serviran para analizar la capacidad de su sistema, por ejemplo:

www.thesycon.de/deu/latency_check.shtml

Inicie esta herramienta con el SESSION /0O desconectado. En caso de que su ordenador no
pueda procesar audio sin experimentar problemas, la herramienta le mostrara barras rojas
de latencia y reportara esto en la caja situada abajo de todo.

En general no se recomienda el empleo de ordenadores portatiles con tarjetas de memoria
grafica compartida. Seguramente va a necesitar toda la memoria y capacidad de procesa-
miento disponibles para sus proyectos de audio.
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Aqui le presentamos algunos consejos para optimizar el desempefio de su portatil:

e No se recomienda usar el ordenador con las baterias porque el administrador de energia
podria hacer atrasar el reloj del CPU para ahorrar consumo.

e Desconecte todo los aparatos que no vaya a usar (p. €j., impresoras y escaneres). Esto ali-
viara el trabajo del ordenador y aumentara la capacidad de procesamiento disponible para
el programa musical.

e | os ordenadores portéatiles estan equipados con dispositivos integrados que pueden per-
turbar el procesamiento de audio, entre los mas comunes se cuentan los adaptadores de
red y la tarjetas inalambricas LAN. Es posible que tenga que desconectar estos dispositivos
cuando quiera trabajar con SESSION 1/0.
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1 Especificaciones técnicas

Esta seccion presenta las especificaciones técnicas relevantes del hardware del SESSION /0 .

1.1 Enchufes:

e 2 enchufes hembra de entrada (In 1, In 2) para conectores mono de %4” (6,3 mm).

e 2 enchufes hembra de salida (Out 1, Out 2) para conectores mono de ¥4” (6,3 mm) (no
balanceados) o conectores TRS (tip/ring/sleeve balanceados).

e 1 enchufe de auriculares para conector de 4" (6,3 mm).
e 1 USB?20TipoB
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1.2 Especificaciones de audio

Entradas de audio (A/D)

Canales 2

Frecuencia de muestreo 44.1; 48; 88,2; 96y 192 kHz
Definicion en bits 16 y 24 bits

Convertidor Cirrus Logic

Entrada de microfono

Impedancia de entrada 4,8 kQ (balanceado)

Nivel méaximo con ganancia maxima | -46 dBu

Nivel maximo de entrada 0 dBu
THD+N 0,008%
Respuesta de frecuencia 10 - 40000 Hz (-1 dB)
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Entrada de linea

Impedancia de entrada

44 kQ no balanceado & balanceado

Nivel maximo con ganancia maxima

-2,19 dBu

Nivel maximo de entrada

+15 dB no balanceado & balanceado

SNR (ponderado)

96,2 dB

THD+N

0,008%

Respuesta de frecuencia

10 - 40000 Hz (-1 dB)

Entradas de instrumento

Impedancia de entrada

1 MQ no balanceado

Nivel maximo con ganancia maxima

-8.3 dBu

Nivel maximo de entrada

+9 dB no balanceado

SNR (ponderado)

95,9 dB

THD+N

0,008%

Respuesta de frecuencia

10 - 40000 Hz (-1 dB)
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Salidas de audio (D/A)

Canales

Frecuencia de muestreo

44.1; 48; 88,2; 96 y 192 kHz

Definicidén en bits

16 y 24 bits

Convertidor

Cirrus Logic

Salidas de linea

Impedancia de salida

100 Ohms no balanceado, 200 Ohms balanceado

Nivel maximo de salida +6 dBu
SNR (ponderado) 100 dBu
THD+N 0,008%

Respuesta de frecuencia

10 - 45000 Hz (-0.5 dB)
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Salida de auriculares

Impedancia de carga 8-600 Ohmios

Nivel maximo de salida 1.67 V eff @ 100 Ohms
SNR (ponderado) 98,2 dB

THD+N (60 Ohms) 0,008%

Respuesta de frecuencia 10 - 40000 Hz (-1 dB)

1.3 Suministro de energia

Via interfaz USB 2.0, puerto de alimentacién de 5 V/ 500 mA

No se necesita ninguna otra fuente de energia o bateria, solamente es requerida la energia
del USB. Sin embargo, sélo se garantiza un funcionamiento adecuado cuando SESSION 1/0
se emplea como el Unico dispositivo conectado a un controlador USB 2.0 0 a un hub USB

2.0 autopotenciado.

1.4 Dimensiones y peso

121 x 115 x40 mm (4,76 x 4,53 x 1,57 pulgadas)
0,56 kg (1,235 Ib)
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1.5 Especificaciones ambientales

Temperatura de funcionamiento: de 0°C a 40°C (32°F s 104°F), (85% de humedad no con-
densada)

Temperatura de almacenamiento: entre -20°C y 50°C (-4°F a 122°F), (85% de humedad no
condensada)

1.6 Requisitos de sistema

1.6.1 Especificaciones generales del sistema

¢ |ntel® Pentium™ o AMD® Athlon™ XP a 1,4 GHz, Windows XP Service Pack 2 o Windows
Vista™ (32/64 bit) y 1024 MB de RAM, USB 2.0

e Mac OS 10.5, Intel® Core™ Duo 1.66 GHz, 1024 MB RAM, USB 2.0

1.6.2 Formatos de controlador soportados
e Mac OS® X: Core Audio™
e Windows: ASIO® (recomendado), DirectSound™, WASAPI™

1.6.3 Plataformas aceptadas
e Mac OS® X: Standalone, VST®, Audio Units™, RTAS® (Pro Tools 7/8)
e Windows®: standalone, VST® y RTAS® (Pro Tools 7/8)
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